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NWS Central Region Convective Warning Improvement Project



This is an introduction/refresher to the Gibson Ridge 2 Analyst
(GR2A) program. It doesn’t cover every single feature, but hits on
those that are the most useful. This manual was made for GR2A
3.2.1.1. Previous versions of GR2A 1/2.x, GR2, and GR3 have
similar interfaces, but differ substantially.

Hopefully you can glean some new information and tricks on using
GR2A. With the right setup, GR2A is a powerful program.

Just want to know what is new with Version 3? Jump to...

User Defined Products (UDP) PTDS Product
Maximum Value Trails New Warning Lavers
Storm Following Mode New Update Notifications

This document is intended for free use by all users of the GR2A product, including public, private and government entities. This training guide is not endorsed by the
developer of the GR products.
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Setting up Level |l Data Feed

;i'ﬁt Time LS8 If you are opening GR2A for the very first time, a pop-up box appears
pdating . .
asking which Level |l data feed to use.

GR2Analyst needs a live source for Level II data, otherwise the Site
menu will be disabled and you will only be able to view archived data.
Iowa State University has a free L2 feed you can use or you can

enter another source.
Unless you have a different feed to What woud you ke to do
use, it is easiest to choose the lowa Use the lowa State L2 feed |
State L2 feed (first option). You can Use  dfferent L2feed ... |
always change these settings later in e GRaanalyst .7 Settings_|
Not set an L2 feed right now |

the File—> Configure Polling menu item.

If you do not set a Live L2 feed right now, you can do so later by
selecting the File menu item and then Configure Polling.

Table of Contents




First Time Use
& Updating

Table of Contents

Note: GR2A does not import

color tables. These need to be

manually configured.
See how to quickly do this!

Importing Old Settings

GR2A can import settings from older versions of the program installed on
your computer.

In the Menu Bar at the top of the program, click File—> Import... and then
choose which items you wish to import.

File View Site BR BV SRV NROT SW ZDR CC PHI KDP PTDS

[Tl Ll | T X | | WS

Open...

Configure Polling...

GPS >
Save Image >
Import... > | Favorite Sites

Exit Placefiles

Road Settings
Site Settings
Bison State/County Line Settings
Volume Alpha Tables
Rush Center  limken Warning Settings

55



Activating & Updating GR2A 3.x

;iﬁ;;::;ﬁguse To activate GR2A, open Help—> About and enter the key you received

at the time of purchase.

GR2A displays a | | icon on the top right corner of the program
when a program update is available. Click the icon to download and
install the update.

Otherwise, the latest update for GR2A can be downloaded here.

It is highly recommended that all GR2A owners join the GRLevelX
Owners Forum to receive product support and update notifications.

Table of Contents



http://www.grlevelx.com/downloads/gr2analyst_3_update.exe
http://www.grlevelx.com/owners/
http://www.grlevelx.com/owners/
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Component Descriptions

=> Menu Bar
Access to nearly all of the settings for GR2A.
=> Toolbar

Program
Layout

Shortcuts for common options. Mousing over a button gives its description.
=> Color Table
Scale for the currently displayed or selected product.
=> Radar Display Window
Displays the currently loaded data.
Live Data

-> Status Bar
Cursor Polling Status

Cursor Readout / Max Radar Beam MESO- & Update Time

Azimuth & Unambiguous Height @ Radar Display
Shapefile Data @ Cursor  Range from Velocity Cursor

Cursor Window AVSET S‘lt\\llulionr
(ex. Road Name) Marker/Radar (VISRV only) (ARL) Coordinates Resolution enabled? ccans
Table of Contents

juzo | 3024°/33.77nm 180 dbz | 2447t | 42030500,-94.363426 145 meters/pixel | AVSET | SAILS1 | Nex Update: 0:25 |



http://glossary.ametsoc.org/wiki/Maximum_unambiguous_velocity
http://glossary.ametsoc.org/wiki/Maximum_unambiguous_velocity
http://glossary.ametsoc.org/wiki/Maximum_unambiguous_velocity

Four Corners Layout

The Product/Tilt Window can be toggled on & off by going to Windows->
Show Product /Tilt Window....

The window shows the available radar tilts and other valuable VCP
information in one place. When toggled off, much of this info shifts to small
boxes placed in the four corners of the Radar Display Window.

Program
Layout

* KTWX - "8 VT: 2019/05/28 - 23:25:31
{ VCP: 212 1 ; RT: 23:25:31
, VT: Volume scan start time

Site ID & VCP ¥ |l PT: Product scan time within VCP

I
AT ikl , .
I § i S - O

BR 0.664°
Product & Tilt

Product/Tilt Window Toggled OFF Product/Tilt Window Toggled ON

“Four Corners Layout” (Right Side of Window)
Table of Contents

Description of the Product/Tilt Window on the Next Page



Program
Layout

Table of Contents

Product/Tilt Window

Site:  KTWX - AVSET SAILS_3
VST: 2019/05/28 23:37:44Z
Prod: 2019/05/28 23:41:56 Z
VCP: 212 SMV: 232° 30 kts
Tit:  0.659°
~Select Product:
B VL " ZDR
By Cwvibp  cC
Csw ( POSH (" PHI
" sRv (" MEHS { KDP
CEr C NROT { PIDS

Site ID & scanning strategy in use, start
time of the volume scan & product scan
time, VCP, storm motion, and current tilt.

Available products to choose from, both
Level Il base & derived products.

" TDEF (" CP30 (" CP40
v (" ce40 " D100

t:

24°| 320

40°| s1°

6.5°

8.0° | 10.0°

12.5°

User defined products (UDPs) are loaded
at the bottom of this list.

“SelectTit: ————————————
|0.7° o.9°| 1.3°| 1.8°|

Max: 67.5dbz
Az: 84.7°
Ran: 52.8 nm

—Product Details: —————————

Available tilts to choose from. If a *
appears next to the tilt, the data is from
the previous volume scan. Some derived
and user defined products will not have
any tilts listed.

Miscellaneous details of the currently
displayed/selected product such as the
location of the maximum and minimum
values.

Scanning Strategy
(MESO-SAILS, MRLE, & AVSET) Notes

MESO-SAILS :

When GR displays the text “SAILS_x”, x is the
number of additional 0.5° slices being
scanned. This number ranges from 1 to 3.

MRLE :

“MRLE_x”", x is the number of additional
low-level tilts being scanned midway through a
volume scan.

MRLE_2 = 0.5°, 0.9°
MRLE_3 = 0.5°, 0.9°, 1.4°
MRLE_4 = 0.5°, 0.9°, 1.4°, 1.8°

MESO-SAILS & MRLE cannot be used concurrently.

AVSET :

If “AVSET” is displayed, the radar is truncating
the volume scan below 19.5° due to a lack of
echoes. Note that AVSET is displayed in the
status bar if the strategy is active, even if the
radar is executing a complete volume scan.

If no text is displayed, no scanning strategy is
being used.




Panels

Radar data can be viewed in 1, 2, or 4 panels in the Radar Display Window. To change
the panel layout, go to Panels and select One Panel, Two Panels, or Four Panels.

Program
Layout e e o e R V) oty ‘\ \\\(\\\\.\ T

o By
AL

Table of Contents

Loop going through the one, two, and four panel layouts.



Panel Editing & Saving

To add a product to each panel in the two or four panel layout, click the panel—it

PE:?;?JT becomes highlighted with a thin black box—and choose the desired product and
elevation from the Product/Tilt Window or Menu Bar.
Panels Warnings Windows Help

Pre-built panels are also under the One Panel
Panels menu. Up to 8 different layouts o banck
can be edited and saved using the FourPenek ey s
Pane/S“’ Save Current Panels as Save Current Panels as > Favorite #1
menu option. 18R P

2SRV Favorite #3

3 BR/SRV Favorite #4
Each panel is numbered 1-8. To open a 4BR/CC ::::::Z
panel, choose it from the list under the ASRV/CC S
Panels menu or select the corresponding :22’/221; Ef/f\:‘::; s
number from the keyboard/keypad. L m

Table of Contents




Program
Layout
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Saving Images

Go to File~> Save Image and select one

of two options:

Entire Window: Captures the whole screen

Radar Only: Captures only the Radar

Display Window

Folder: | C:\

File Spec: | %r_%D_%T_%P

[~ File Spec Format Help: -

%r inserts the radar site in lower case, eg kffc”
%R inserts the radar site in upper case, eg "KFFC"
%D inserts the product date, eg "20060107"

%T inserts the product time, eg "2359"

%P inserts the product name, e.g. "BR_0.5"

Save

_seve |
_concel|

Configure Polling...

GPS >

Save Image > R Ente indow
it Radar Only
Exit

GR2A can insert certain variables (site 1D,
date, product time, and product name) into
the image filename, as well as any
user-desired words/characters at any
location in the filename.



Changing Current & Startup Sites

Site:  KTWX Lattude:  38.997 (2.5
. . B Office:  KTOP ::: asf:i Cancel
Radar Site To change the current site, go to Site— Select... s o |
Settings - Choose your site from the list that opens and click OK. e
Sites that begin with the letter “T” are TDWR sites. @B s 1
=> You can also change to a nearby site by clicking on ;‘“g ;N ;f;"wm
the radar ID in the Radar Display Window. @ 5 o

To change the startup site

Site Settings >4

= Go to Site—~ Settings... “starup e o
KDMX Des Moines, 1A Change I
=> In the Startup Site box, click Change and select I komatcaly ot ot st
the site from the provided list X

AN

-Favorite Sites: -

-> To have GR2A begin polling this site at startup, / %aﬁ;@fg’fﬁ |
check the Automatically connect at startup box. REAY Kansas iy, MO camove |
KMPX Minneapolis, MN

-=> Click OK once done KOAX Omaha, NE

Table of Contents




Favorite Sites

Site  BR BV SRV NROT SW ZDR

User-defined favorite radars are displayed in the Site menu £ Zoe™ R
Radar Site . . . . . ¥ Settings... =
Settings - Sites are displayed in alphabetical order by site ID KARK La Crosse, Wi 7

KDMX Des Moines, 1A
KDVN Quad Cities, IA
KEAX Kansas City, MO

To configure Favorites: KFSD Sioux Fals, 5D B
KMPX Minneapolis, MN
- Go to Site Settings... oo e

KOAX Omaha, NE

- |n the Favorite Sites box, click Add

Site Settings X
- Select the site from the list and click OK = — x
(You have to do this for each site) '

[~ Automatically connect at startup

To remove a site from your favorites, select the i
site from your list and click Remove. (OWN Quad s, 1A [ a |
KEAX Kansas City, MO
To add the currently displayed radar site as a favorite, KX Grand Fors, O
Table of Contents g to Sjte—> Add to Favorites...




Live Data

L;:gi;g To start downloading live data
Imagery - Click the Start Polling button | € | on the Toolbar.

=> Note: A polling site must be configured beforehand, either when the
program was first set up or via the Configure Polling setting.

To load previous volume scans
- Click the Download Recent Data button | @ | on the Toolbar.

=> To configure how many volume scans GR2A downloads and how often it
polls for data, see the Configure Polling section.

To stop live polling without shutting GR2A down
=> Click the Stop Polling button |€& | on the Toolbar.

Table of Contents




Configure Polling

Loading Navigate to File-> Configure Polling...
Radar (You cannot be downloading live data while changing these options)
Imagery The window that opens up displays the sources of Level |l data. The

buttons on the right allow you to add/remove new sources and change
their priority (top source is used first).

G

onfigure Polling

There are three configurable options:

- Level2 Sources:
https://mesonet-nexrad.agron.iastate.edu/level2fraw/

=> Polling Interval: How often GR2A
checks for new radar data.

-> Retain files for: How long GR2A

keeps the files it downloads before

d i S Ca rd i n g th e m . . Polling Interval: I 30  seconds (10 or more) [~ Automatically Refresh Sources
. Retain files for: IT hours (2 or more)

> Keep in memory: How many scans  [@xeenmenon: [ vomes 229

GR2A keeps in memory that are
Table of Contents : : : The Automatically Refresh Sources checkbox is useful if new
available for anlmatlng' radars are added in the future. It is disabled by default.




Archived Data

Loading

Radar In Menu Bar go to File—~> Open...
Imagery _ o File View Site BR BV SRV
- Navigate to the folder containing the data, use the

shift key to highlight the desired time range, then

Open...

Configure Polling...

click open. f
GPS > :
You can also drag & drop radar files you wish to s ;N
load directly from the File Browser into GR2A. w— B
A maximum of 24 radar files can be loaded into the Exit
program at one time. |l v

Depending on the size of the radar files and the computer hardware, the dataset may take over

a minute to load. This is especially true for files containing MESO-SAILS or MRLE data!
Table of Contents




Radar Products

Level Il Products Ingested by GR2A Calculated Products within GR2A
Navigating

Radar Data Base Reflectivity (BR) Storm Relative Velocity (SRV)
Base Velocity (BV) Echo Tops (ET)
Spectrum Width (SW) Vertically Integrated Liquid (VIL/VILD)
Differential Reflectivity (ZDR) Probability of Severe Hail (POSH)
Correlation Coefficient (CC)  Not Available w/| Maximum Estimated Hail Size (MEHS)
Phase Shift (PHI) TDWR Data Normalized Rotation (NROT)
Differential Phase Shift (KDP) Probability of Tornadic Debris Signature (PTDS)

Product Notes:

PHI is an extra dual-pol product is available in GR2A that is not
viewable elsewhere. This is the differential phase shift before a
distance derivative is applied.

PTDS (right image) is the weighted sum of various products (BR,
CC, ZDR, PHI, SW, and NROT) for ascertaining the presence of a
Table of Contents TDS. See Help—~> User Guide... for more information.

CC (left) and PTDS (right)



Navigating
Radar Data

Table of Contents

User Defined Products

The User Defined Product (UDP) feature of GR2A allows one to calculate new
products using baselined products in the program and RAP environmental data.
This opens the door for the creation of dozens of new products!

Two Ways To Load a UDP

1. Drag and drop the file (.rsl or .rsl.txt) into the Radar
Display Window.

2.  Open Algorithms— User Products, click the Add
button, and navigate to the file.

The User Products Manager (right image) is also used to
arrange the order of UDPs and remove them.

You can only have 6 UDPs loaded into GR2A at a time.

To display a UDP, click on it from the Product/Tilt Window or from the USER menu.
When polling live data, UDPs are calculated after the completion of a volume scan.

User Products Manager

—Installed Radar Shaders: ———————

TDEF
CP30
CP40
CG40
D100
D075




Examples of User Defined Products

Estimated Tornado EF-Scale Intensity

Navigating
Radar Data

Baldwin City)

e-10°C

Vertically Integrated Ic
| ~— -.‘-.- | § s B — i v oo T ; , N | = @ e

[ Baldwin Gity,

Table of Contents

Visit the GR Owners Forum for UDP examples and Help—> User Defined Products... for information on creating a UDP.



http://www.grlevelx.com/owners/

Navigating
Radar Data

Table of Contents

Changing Products & Elevation Angles

Using the Program:

Chose the desired product & tilt in the Product/Tilt Window @
or the Menu Bar @. If a * appears next to the tilt, the data is
from the previous volume scan.

‘ IBR BV SRV NROT SW ZDR CC PHI KDP PTDS DERIVED USERI

Using Keyboard Shortcuts:

=>  Tilt: The up/down keys move vertically through the tilts in
a volume scan.

=> Product: The keys that correspond to each product are
underlined in the Product Information panel.

A reference guide under Help—> Keyboard Help also
contains these shortcuts (image to right).

ect Product: ———————————
*BR VL

" DR
Cwvip  cc
" PHI
" kDP
" pPIDS

By

 sw
" SRV
CEr C NROT

" POSH
 MEHS

" TDEF " CP40
v G40

" D100

SelectTit ——
i| o ==

GR2Analyst Keybo

R BR
v BV
S SRV
w sw
£ ET

ard Help

[~ Product Category Keys

L

D
o
M
N

VIL
VLD
POSH
MEHS
NROT

4 A" TON

[~ Favorite Panel Keys

1 Change to Favorite Panel Set 1
2 Change to Favorite Panel Set 2

8 Change to Favorite Panel Set 8

[~Product Tilt Keys

Up Arrow

Higher Tilt

Down Arrow  Lower Tilt

~Loop Control Keys
LeftArrow  Step Backward in Time
Right Arrow  Step Forward in Time
Space Start/Stop Looping

[~ Misc

F  Toggle Storm Following Mode




Navigating
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Precipitation Type

GR2A calculates the expected type of precipitation reaching the ground in areas with radar echoes
using RAP model data (surface observations not used).

Selecting the button on the Toolbar colorizes the base reflectivity imagery by four p-types:

Liquid Freezing Rain Sleet Snow

To view the raw base reflectivity data again, deselect the button.
Product Notes:
Precipitation type is only calculated for CONUS, real-time radar viewing (not archived data).

This is not a hydrometeor classification algorithm (HCA) product. The HCA calculates the
characteristics of the precipitation sampled by the radar beam at each elevation angle, while the
Precipitation Type algorithm calculates the expected precipitation type at ground level.



Navigating
Radar Data

Table of Contents

Animation

Use the Left and Right Arrows on the keyboard to step through the data.
The Spacebar activates/stops looping.

The toolbar also contains animation controls:

First Image PIaylPause Loop Last Image in

in Sequence Sequence
\f |< <| > N(

Previous Image Next Image

To control looping speeds, see the Animation Settings section.




Zooming & Panning

There are 3 ways to zoom in/out:

Navigating

Radar Data Right-click & hold on an area in the Radar

Use your scroll wheel to zoom into Display Window and drag outwards, forming a
wherever your mouse is located on box that GR2A zooms in to.
the Radar Display Window. 2T

Use the zoom controls on the toolbar.

Zoom Out Zoom
Zoom In % &~ None

N N N f "

Panning: Click the |s¢| button on the Toolbar, then click and drag within the Radar
Display Window to move the viewing screen around. You need to select this option

Table of Contents when exiting from Cross Section or Volumetric mode.



https://docs.google.com/file/d/12es5s4JETkGTVu8En4sA1i_Vlzhryduu/preview
https://docs.google.com/file/d/12es5s4JETkGTVu8En4sA1i_Vlzhryduu/preview

Storm Following Mode

Once a Storm Motion is set, selecting the “F” key invokes the Storm
Navigating Following Mode. This shifts the radar viewing window at the same pace as
Radar Data the storm motion when using the animation functions, ideally keeping the
storm centered in the screen.

Table of Contents



https://docs.google.com/file/d/1z6joQ-3al8suj_HPgqVZ5v9Zh6h3WVLQ/preview
https://docs.google.com/file/d/1z6joQ-3al8suj_HPgqVZ5v9Zh6h3WVLQ/preview

Changing Color Tables

Drag and drop color tables (.pal files) from a file browser into the Radar Display

Viewing Window. You don’t even have to be on the matching product in GR2A to load them!
Options
Changing using the Menu: e %
- Navigate to View- Color Table R Sateoy | Cose |
Settings... P Change I Use Default |
SRV
- Choose the product you wish to ey
set on the left side of the screen. o ;
el —Category Details:
=> Click Change and select the color res Maximum Value: 94.5
table file from the file browser. Z0R Minimum Value: -32
gn-cu Internal Units: DBZ
-> Repeat for each product you wish KDP
to change. L

Table of Contents For help in creating a color table from scratch, visit Help—> Color Tables.




Markers

Markers are useful for setting the storm motion and measuring distances between points.

Setting a Marker

(Erased when GR2A is closed)

Right-click on the Radar
Display Window where you
want to place the marker.

Storm Track Here

Remove Storm Track

Place Marker Here

Remove Marker

Storm Motion From Marker

Storm Motion From Warning

Viewing

Options
-
9
N

From the pop-up menu, select
Place Marker Here.

To remove the marker, select
Remove Marker from the same
menu.

Place Home Here

Remove Home

Setting a Home Marker
(Remembered by GR2A)

>

Right-click on the Radar
Display Window where you
want to place the home marker.

Measure From Marker
Measure From Home

Measure From Radar

Zoom None

Show Range Rings
Reload Visible Tiles

From the pop-up menu, select
Place Home Here.

To remove the marker, select
Remove Home from the same
menul.

GR2A shows the distance from a radar or active marker in the Status Bar. You can force GR2A to
measure from certain points.

Table of Contents

Right-click the Radar Display Window and choose one of the three Measure From... options in the pop-up
menu. The selected point turns red on the Radar Display Window while the other options turn yellow.




Setting Storm Motion

Remove Marker

If you have warnings available, right click the
Viewing polygon and from the pop-up menu select
Options Storm Motion From Warning. —

Storm Motion From Marker

Storm Motion From Warning

Place Home Here

Manually calculate storm motion:

1. Right click on a feature and set a marker.
Storm Motion From Marker
Storm Motion From Warning\ 2. Advance several frames forward or backward.

3. Right-click on the same feature and from the pop-up
menu select Storm Motion From Marker.

Manually enter storm motion: Set Storm Motion Vector x
Click the icon in the Toolbar. A window pops up allowing you to From: [ M3 degrees Ecm |
enter the storm’s motion and speed. s (P
Table of Content
st Vi e NOTE: Storm motion is the direction the storm is COMING from. poply_|




Storm Track

Viewing GR2A can show a one hour predicted storm
Options track based on the set storm motion in 15 minute
increments.

Note that this is a static track and does not
automatically update as new radar data arrives.

To Add: Right click on storm and from the Storm Track Here

R /e S Track
pop-up menu select Storm Track Here. % STV SN e
Place Marker Here

To Remove: Right click and from the Storm Track Here

pop-up menu select Remove Storm Track.
Table of Contents : Place Marker Here

Remove Storm Track




Show Panel Center

Viewin Clicking the [B|button when in a 2 or 4-panel viewing mode places
optiong that icon in the center of each pane. Very useful for checking the
alignment of radar signatures (like TDSs).

Table of Contents



https://docs.google.com/file/d/11pG9XvVRRiiOhdNeOVSABRJWDDZqOmB6/preview
https://docs.google.com/file/d/11pG9XvVRRiiOhdNeOVSABRJWDDZqOmB6/preview

Dealiasing

BV/SRV dealiasing can be toggled on & off with the [H] button on the

Viewing Toolbar (must be viewing a BV/SRV image to have the button active).
Options

To Fix Bad Velocity Data:

Open the View— Dealias Settings... and toggle on/off the Use Wind Dealiocing Setfings
Profile checkbox. This often improves the data, but likely won’t fully

. oK
resolve the issue. I™ Convert Unresolved to ND |

Cancel

I [V Use wind Profile I

Pro Tip: Deselect Convert Unresolved to ND so that all velocity data
is shown, even if GR cannot properly display it. This alerts you to try

Table of Contents

the above fix versus GR simply showing no data.



Maximum Value Tralils

Activating the || button on the Toolbar shows the maximum values for
Viewing a selected product/tilt at all times loaded into GR2A. Clicking the
Spticns button again deactivates the feature.

This is useful for BR or other derived and UDP products, but is more limited for
velocity products or those in which you might want to see a summation of the
lowest values (such as ZDR & CC).

Table of Contents

PTDS Maximum Value Trail NROT Maximum Value Trail



Product Sampling

Hold down the CTRL key while mousing over radar data to view an
‘éiet"_"ing active readout of the data and expected beam height (above radar
D level) next to the cursor.

This same active readout (without
needing to hold the CTRL key) is
available in the Status Bar below the
Radar Display Window.

-68.0 kts / 67.4 kts =
For BV/SRYV, the second value after

the “/” is the maximum unambiguous
velocity that the current PRF supports
before velocity folding begins.

Table of Contents



https://glossary.ametsoc.org/wiki/Maximum_unambiguous_velocity
https://glossary.ametsoc.org/wiki/Maximum_unambiguous_velocity

Viewing
Options

Table of Contents

Rotational Information

After setting a marker on one side of a circulation, hold down the
CTRL key on the other side of the circulation to view Vrot, EF-Scale
probabilities, and other data about the circulation.

27:.2:kts / 67.4 kts

2649 ft ARL

Vin = -68.0 Vout = 27.2 kts
DV = 95.2 kts Dia = 0.27 nm

AzShear = 98.5 /ks
Vrot = 47.6 kts

EFl+ EF2+ EF3+ EF4+
Cond: 63 24 5 0

Window Components

Sampled Velocity / Max Unambiguous Velocity (kts)
Sampled Beam Height (ARL)

Velocity Inbound (kts) Velocity Outbound (kts)
Velocity Difference (kts) Diameter of Couplet (nm)
Azimuthal Shear (0.001 * s-1)

Rotational Velocity (|Vin|+|Vout|/2) (kts)

Conditional Tornado EF-Scale Probability using Vrot
values in case studies from 2009-2013. Please read

the article to use this technique properly!


http://glossary.ametsoc.org/wiki/Maximum_unambiguous_velocity
https://vlab.noaa.gov/web/wdtd/-/azimuthal-shear
http://www.spc.noaa.gov/publications/smith/vrot-env.pdf

Toolbar Buttons & Units

Viewing 6 Show Radar Data: Toggles radar data in the display window.
Options

& | Smoothing: Toggles smoothing for
non-velocity products.

To configure smoothing settings, navigate
to View— Smoothing Settings... These
settings normally do not need changing.

‘ Show Hail Icons: Toggles GR2A calculated hail size icons.

V¥V | Show MDA Icons: Toggles GR2A calculated TVS/Meso icons.

To view distances in metric units, enable the menu item View—> Show Metric

Table of Contents . . . . . .
Units. Use the same menu item to switch back to imperial units.




Warnings & Storm Reports

Warnings Windows Help
Show SQW
Show SMW
Show FFW
Show FFWC
Show FFWE
Show SVR
Show SVRC
Show SVRD
Show TOR
Show TORR
Show TORP
Show TORE

NWS warnings are toggled on/off using the Warnings menu option. Warning Types. I:>

Overlays
Mousing over a warning polygon in the Radar
B oo wae Lbomre e e e wnieg®  Display Window displays basic information about
BRREheRRE MERD R the warning, such as the IBW hazards, & storm
f Moving northeast at 27 kts location/movement.

Max Hail Size: 1.50"

(S SR P SO SR S ST SR

Clicking on a Warning Polygon o opens the full warning
text & follow-up statements.

Active CONUS warning data only can also be accessed from
the Windows-> Show Warnings Window pop-up box.

Show LSR Icons: Toggles NWS Local Storm
D Reports (LSRs) valid for the last hour. Mousing over
an LSR icon @ allows you to view the full LSR text.

GR2A downloads historical NWS warnings (since 2006) and LSRs (since 2003)

Table of Contents with archived radar data. These appear and disappear as though it were real time.




Warning Types & Abbreviations

NWS tornado, severe thunderstorm, and flash flood warnings are styled based on Impact-based warning
tags that are appended to the bottom of the warning text. Some of the GR2A warning tag verbiage differs
from the official tag text and is clarified in the table below. See how to change warning colors.

Overlays

Tornado Severe Thunderstorm Flash Flood

SVR - No Tags

TORR - Reported SVRC - Considerable
(Tag: Observed) (70 mph wind and/or 1.75” hail)

TORP - PDS SVRD - Destructive
(Tag: Considerable) (80 mph wind and/or 2.75” hail)

TORE - Emergency
(Tag: Catastrophic)

Table of Contents SQW - Snow Squall




Placefiles: Introduction

Placefiles are custom text files developed by third parties that are
specifically designed for GR products.

Overlays

These can be static files (CWA outlines, PR =]

wind farms locales, spotter residences) or |+ =¥
. [T I~ NWS/FAA Full Metar Plot (KDMX) - 2:150m CS
dynam|Ca”y updated on a server (Surface [T I C:\Users\Kevin Skow\Documents\Gibson Rid

. [T ¥ Satelite Visual Northem Plains
observations, SPC outlooks and watches, I 6 bt D0 ot

we bcam |mag eS) . [T I~ SPC Valid Mesoscale Discussions
[T ¥ SPC Watch by County

W Local Storm Reports - ALL

To load either type of placefile, make sure
the Windows—> Show Placefile Manager
option is checked. When it is checked, a
small window opens on the screen.

Table of Contents




Overlays

Table of Contents

Placefiles: Loading

Click the |3 |button on the Placefile Manager to open the window below.

Load Place File X

To load a static (saved) placefile, click the
on the computer.

button and navigate to the file

To load a placefile located on the Internet, simply paste the address to the
placefile in the text field.

Click OK when done. Repeat this process for every
placefile you wish to load.



Overlays

Table of Contents

Placefiles: Managing

To reorder the placefiles, select the placefile in the
manager and click either the [ §]or [ #] buttons.

Note: The Placefile Manager list is a drawing order, not layer order. The
placefiles higher on the list are “drawn” before those farther down the list. If you
wish for a placefile to be shown above another placefile, ensure it is lower on
the list.

If a placefile cannot be loaded, it is highlighted red. To

remove a placefile, select the placefile and click the E|
button.

The left checkbox next to each placefile toggles
whether the placefile is loaded into the program.

The right checkbox toggles whether the placefile is
visible above (unchecked) or below (checked) the radar
image.

Placefile Manager n]
=¥ 2

[V ProbSevere objects - 20230527_174440Z

[T Local Spotter Database - 6/26/2020

[ [ Spotter Network Positions (96dpi) - All

[V [~ Special Weather Statements KARX (17:39Z 05/27/2023)

[~ ¥ RTWX - Full METAR Plot Loop (KARX) 21:07Z Wed May 17

[~ [¥ ENTLN Total Lightning data

[V [ DSS events (all times in US/Central)

[V [ Latest 15min all mPING reports

[T I~ RTWX AHPS River Gauge Plot (KARX) - 16:28Z (11:28am CDT) Sat May 27
VI~ RTWX- Temperature Loop (KARX) 17:44Z Sat May 27

Dewpo op a
[T RTWX - Wind Barb Loop (KARX) 17:44Z Sat May 27
[V http://www.meteor.iastate.edu/~jpatton/watch/countywatch.txt
v
[V [~ MLCAPE-CIN Bundle | Valid: 18:00Z Sat May 27 2023
[~ I~ QLCSTornado Bundle | Valid: 22:00Z Wed May 17 2023
[T~ Most-Unstable CAPE (J/kg) | Valid: 22:00Z Wed May 17 2023
[T 0-3 km MLCAPE (J/kg) Filled Contour | Valid: 22:00Z Wed May 17 2023
[~ I~ 0-3 km Lapse Rate (C/km) | Valid: 22:00Z Wed May 17 2023
[T~ Mixed-Layer LCL (m) | Valid: 13:00Z Thu May 12 2022
[~ I Effective Bulk Shear (kt) | Valid: 17:00Z Fri Mar 31 2023
[V [ Effective Storm-Relative Helicity | Valid: 18:00Z Sat May 27 2023
[~ " 0-500 m Storm-Relative Helicity | Valid: 17:00Z Fri Mar 31 2023
[T~ 0-1km Storm-Relative Helicity | Valid: 17:00Z Fri Mar 31 2023
[~ " Deviant Tornado Motion (kt) | Valid: 17:00Z Fri Mar 31 2023
[T~ Bunkers Right Vectors (kt) | Valid: 01:00Z Sat Apr 01 2023
[~ I~ Bunkers Left Vectors (kt) | Valid: 20:00Z Fri Mar 31 2023
[T~ Non-Supercell Tornado Parameter | Valid: 17:00Z Fri Mar 31 2023
[T I Effective SigTor Parameter | Valid: 17:00Z Fri Mar 31 2023
[V~ NWS ARX
[V [~ ZDR Arc-Deltas Algorithm Placefile




Overlays

Table of Contents

Placefiles: Locations

Below is a list of online placefiles (non-exhaustive
and not endorsed by the NWS). Please note that the
reliability of these third-party placefiles is not
guaranteed.

Red Team Wx: A wide array of surface obs & outlooks.

CIMSS: ProbSevere & LightningCast.

lowa Environmental Mesonet: lowa surface obs (all
networks), webcam images, NEXRAD Level 3 attributes,
warning information.

Spotter Network: Spotter Network locations and reports.

WxJoe: mPING and NWS Spot requests.
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http://redteamwx.com/grlevelx.html
https://cimss.ssec.wisc.edu/severe_conv/training/training.html
http://mesonet.agron.iastate.edu/request/grx/
https://www.spotternetwork.org/pages/feeds/gibson-ridge
http://gr.wxjoe.com/

Overlays
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Shapefiles

Shapefiles are static GIS files created by third parties that are
supplemental to the overlays already provided in GR2A. Shapefiles require
both a “shape file” (data) and a “style file” (modifies look of data).

-

-

To load, go to GIS— Load ShapefFile.

In the left hand box, click the
button and select the .shp file.

In the right hand box, click the [ -]
button and select the .sty file.

Once both of these are loaded, click
the Import button.

~Shape File:

Fie\

Records:

To remove a shapefile, go to GIS— Unload ShapeFile and chose the file you wish to
remove.




GIS Data, Range Rings & GPS Data

All overlays in GR2A . To show/hide range rings (25 nm it
. . . Show Range Rings
Overlays can be toggled on or . increments), right click the L e
. Radar Display Window and

off by clicking the
corresponding item in
the GIS menu.

from the pop-up menu toggle the
Show Range Rings option.

By default, range rings are

v Show ShapeFiles centered on a radar location, but
Shows Dlaces . can be centered on both .
. markers & home markers if
+  Show Base Roads GR2A is set to measure
v Show Base Counties . distances from these points.
v Show Base States e
+  Show Background :
. If you have a GPS attached to your computer, you can display
v Show County Names . your location using the File-> GPS- Start menu item. To
Show City Names deactivate the GPS, select File-> GPS- Stop.
Show Radar Sites . A GPS monitor window opens up when a GPS is active and can
Table of Contents :

* be turned off using the Windows—> Show GPS Monitor option.



Introduction to Cross Sections

Cross Cross sections can be made from all Level |l products and SRV.
Section
Mode
TO Create d CrOSS SeCtion Toolbar Product Information Panel
z 3\

-=> Click the button on the
Toolbar to activate the
cross section tool.

-> Click & drag your mouse
across the area you wish
to take a cross section.

—-> Release the mouse button
when finished and a
separate window opens.

Table of Contents

Status Bar



Cross
Section
Mode

Table of Contents

Window Components

Product Information Panel

~Volume:

[~ Select Product:

[~ Adjust Slice:

Date: 2019/05/28
Time: 23:12:37Z

@ BR " ZDR
" BY §_Ee
Csw  { PHI

" spy " kDP

Position Swing

a

Product date & time. Toolbar B < <>y C

Products t9 load as a SR - Animation Controls Refresh w/

cross section. ave Ima Can also use Main Window
left/right arrow keys

Position: Moves the cross section back & forth in the horizontal on a line
tangential to its orientation.

Swing: Pivots the cross section on its left axis by about 30° in either direction.

¥ smoothing Toggles product smoothing. Only works if smoothing is enabled in the main window.
Ready | 266°/755nm 560 dbz 13991 ft | 38.908241,-07.846443
Status Bar Azimuth/Range elulle lugllze Coordinates if Mouse is

Program Status from Radar or Product Product

Marker Value Altitude over Background Map




Data Viewing & Environmental Overlays

Cross Rotating & Tilting: Clicking & dragging with your mouse around the
Sﬁ‘;té‘;" cross section window allows you to rotate the image in the horizontal

and tilt the image from 0° to 90° in the vertical.

If environmental data are available, GR2A plots the 0° C and -20° C

levels on the cross section as yellow and lines, respectively.

Table of Contents




Introduction to Volumetric Mode

Volumetric displays provide a three dimensional look at a storm and

Volumetric are available for BR, BV, SRV, SW, KDP, and NROT.
Mode

To Create a Volumetric Window: Toolbar Product Information Panel

> Click the [£] Toolbar button to
activate the volumetric mode.

=> Center your mouse in the middle
of the area of interest then click &
drag outward. A box grows
outward with your cursor showing
the area to be analyzed.

-> Releasing the mouse button
opens the volumetric display in a

Table of Contents new window.

Status Bar



Window Components

Radar Display
Volumetric . . .

Mode Shows a smoothed, 3D volumetric image overlaying its 0.5° product.
Click & drag your mouse on the display to rotate/tilt the image. As with
cross sections, the 0° and -20° C levels are shown if available.

Product Information Panel Toolbar Light Settings: Change the
Volume Display Settings: ambient |ight and light angle.
Volume: - Sampling resolution & sky color
e “oBpera Volume scan start
Time: 23:12:37Z i -
= nwr )| datedtime. o B« <w» >| ¢ »L m
fm Cxv | §
cs cwor || Products to load. Y
LS Animation Controls Volume
................................................ Save Refresh w/ Alpha
View Mode: ! Can also use Main Window
& Ut volume Lit Volume: Displays data Image left/right arrow keys Settings
Ckearfee || using user-configured
transparent layers. e _—
131°/564nm | 43.206680, -90.210503
Isosurface: Only display Status Bar )
. A h/R A
Table of Contents dEiE 5 A e e v e zfer::Ra::rge Cursor Coordinates




Volume Alpha Editing

In Lit Volume mode, choose the product you wish to edit from the Product
Voliimatiic Information Panel, then click the |@| Toolbar icon to open the Volume Alpha
Mode window.

The product color scale is oriented along ——

the bottom of the window with a line iokme AR | 02 d0 ]
stretching from the left to right side of the
black window.

— Opaque —

This line controls the opaqueness of the
colors on the scale under it. The closer the
line is to the top of the window, the more
opaque the color.

— Transparent —

A series of click & drags with the mouse in
I E o

the window edits the color transparency.

Tip: When editing the transparency curve, the exact value of your cursor is displayed at
Table of Contents the top of the window (red circle).




Volume Alpha Editing Example

Volumetric
Mode

In the above video, the Volume Alpha is adjusted from its defaults so we can observe the
core of a thunderstorm and still see details of the outer storm structure. The original
Table of Contents adjustments are also edited to further lessen the opaqueness of the lower reflectivity values.



https://docs.google.com/file/d/1wsrp6bc3pILA0ebCd75DxtM5nszr0_Cp/preview
https://docs.google.com/file/d/1wsrp6bc3pILA0ebCd75DxtM5nszr0_Cp/preview

Volume Alpha Examples

Volumetric

Mode Ideal Use:

Hail Detection

Ideal Use:

Viewing All Levels

Velocity

Note that transparency effects
are applied to both inbound &
Junundﬂmﬂu H 1 outbound values.

Table of Contents




Isosurface Editing

Isosurfaces are 3D plots of contiguous product values.

. To change isosurface values:
Volumetric

Mode => Choose the applicable radar product and isosurface radio button from the
Product Information Panel.

\7

Select the |E| Toolbar icon to open the Volume Alpha Settings.

7

Click & drag the triangle under the color table.

Examples

Table of Contents




Saving Settings

To save volume alpha or isosurface settings:
Volumetric

Mode

Volume Alpha - [ 17.9 dbz ] =

-> Right-click the editing
window and select Save
Alpha Table...

-=> Enter a name for the color
table and click OK.

To load your settings, right-click
the editing window and choose it
from the same pop up menu.

“Default” is a saved setting in the example to the right.

You can only load saved settings on the product for which they were created for
(i.e. you cannot load the saved settings for a reflectivity product on a velocity product).

Table of Contents




Backgrounds

GR2A automatically downloads aerial imagery to use for a background

Editin . . . .
Settinggs image. You can toggle this imagery off and use a single color instead.
To change this color, go to GIS— Settings— Coumy ot
Background Color... and set the color. Chy Fort
City Thresholds
The BMNG/Landsat Colors... & NAIP Colors... menu items configure the Radar Sites
aerial data and shouldn’t need to be modified. Roads
. . . S i
To turn off high-resolution aerial data, uncheck the B:Z::::iyl::“
GIS— Settings—> Enable NAIP Imagery box.

Background Color...

To reload the background imagery, right-click the BMNG/Landsat Colors...
Radar Display Window and from the pop-up menu hAlR:Colors:
select Reload Visible Tiles. v Enable NAIP Imagery

Table of Contents




Editing
Settings

Table of Contents

GIS Icons

Overlays in GR2A can be customized
under GIS— Settings. This includes:

County, city, and radar site names: font color/style
Road & boundary lines: color & size

City Thresholds defines the types of cities
shown at a particular zoom level.

Roads also defines the types of roads shown
at a particular zoom level in addition to their
color/line thickness.

Show Always List defines what cities are
always shown regardless of the zoom level.

GIS

v Show ShapeFiles

SO ) Sl L%

<

v Show City Names
v Show Radar Sites

Panels Warnings Windows Help
Load ShapeFile
Unload ShapeFile

Show Places

Show Base Roads
Show Base Counties
Show Base States
Show Backgreund

Show County Names

Settings >

County Font
City Font

City Thresholds
Radar Sites
Roads

Show Always List

Boundary Lines

Background Color...
BMNG/Landsat Colors...
NAIP Colors...

Enable NAIP Imagery




Editing
Settings
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Warning Colors

To customize the look of warnings, go
to View— Warning Settings...

The warning server shouldn’t need to be
modified (http://warnings.cod.edu/).

Click the colorized line next to a warning
label to change line color(s), style, and
width.

To toggle between default NWS colors
and GR2A colors, click the appropriate
button on the right side of the window
(red circle).

Warning Settings

—Warning Server:

i http:/fwarnings.cod.edu/

—Warning Lines:

sQwW

SMW

FFW

FFWC

FFWE

SVR

SVRC

SVRD

TOR

TORR

TORP

LRI NRRN

TORE

Snow Squall

Special Marine

Flash Flood

Flash Flood - Considerable

Flash Flood - Emergency

Severe Thunderstorm

Severe Thunderstorm - Considerable
Severe Thunderstorm - Destructive
Tornado

Tornado - Reported

Tornado - PDS

Tornado - Emergency

Click the line sample to edit

X

Close

NWS Colors
GR Colors




Logo

To set a custom logo on the top left corner of a viewing window,
Editing open View- Logo Settings....
Settings You can set different logos for the three viewing window options within GR2A
(cross section, main, and volume explorer).

Click the Change button to load the logo file from your file browser and the
Clear button to remove it from a particular window.

Logo Settings // X
~Logos:———————| Selected Logo File:

. - ] u’ ————

Cross-Section Window Logo L‘ 08— & ""4‘

Main Window Logo NWS LA CROSSE

Volume Explorer Logo ] Eibey NATIONAL OCEANIC AND ATMOSPHERIC ADMINISTRATION ‘
Change ope

Table of Contents




Editing
Settings
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Animation Settings

These settings are very useful for controlling zoom & looping speeds

Go to View- Animation Sefttings...

Zoom Steps: Smoothness of the zooming.

Higher numbers = smoother, but slower.

Zoom Amount: The degree which the
program zooms in or out with each button
click or turn of the mouse wheel. The default
value of 1.25 is a good starting point.

Speed: How fast the images loop.

Hold Last: How long GR2A holds the last
image in a loop.

Zoom Steps: I £
Zoom Amount: I 1.25

Fast

Slow

~Hold Last:
Long

Short




Algorithms

Editing VIL & Echo Tops Calculations
Settines Algorithms-> Algorithm Settings...

Max VIL DBZ: Maximum reflectivity to
be used in calculating VIL.

Echo Tops DBZ: Lowest reflectivity
value to be used in calculate ET.

MDA Threshold Settings
Algorithms—> MDA Settings...

Can change the ROT threshold and
count at certain ranges from the radar

dotccn 3 o (probably won't need to change).

Algorithm Settings

X

Max VIL DBZ: | EEEN0) ‘II

EchoTopsDBZ: | 18.5 ==
GR-MDA Settings X
MDA Parameters
- » [ ox |
Range  Threshold Count Cancel |
< 20km I B ks 5
Defaults |
<qom [ 20 ks 4
< 60km | 12 ks 3
< 80km | 8 ks 2

soom | & M [ 2




Environmental Data

GRZ2A downloads RAP model soundings when polling live radar data in order
Editing to calculate hail sizes and for use in UDPs.

gettings These soundings can be found in Algorithms-> Environment Settings...

Dates that contain data are are viewable on the left column.

Once the date is selected, the data for each
hour is viewable as a row in the window

(00 and '200 C heights aISO Shown). Environmental Data for karx X
. Dates: Records:
To add paSt Soundlng data 2023/05/27 23:00 10654 ft 21138 ft
> Go to NOAA RUC Soundings. sasroern Wl e navc (S
2023/05/19 20:00 10936 ft 20863 ft
-> Choose RAOBSs as the data source. 19:00 11161 fr 20772 ft Delete |
-> Select the date. 2023/05/16
2023/05/15
- Type the ID of the closest RAOB site. 2023/04/28
. B 2023/04/27 s
= Click the Ascii text (GSL format) button. anz%/ b/ 20 _cese |
-> Copy the entire text sounding data and click Paste zggg;g:g;
in the Environmental Data window. 2023/04/19
Table of Contents -> GR2A confirms that the data was added. e



https://rucsoundings.noaa.gov/

